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E STABLISHED IN 1976 (we’ll celebrate our 40th anniver-
sary next year), DMA is a group of Dayton–area profes-

sionals and hobbyists in the meld of computing and infor-
mation technology. General membership meetings are usual-
ly on the last Tuesday of each month. DMA has a number of 
Special Interest Groups (SIGs) in areas ranging from digital 
investing and genealogy to the Linux operating system. Each 
SIG meets according to its own schedule. DMA is a member 
of the Association of Personal Computer Users’ Groups 
(APCUG) and the Aoliated Societies Council (ASC). Click 
on any of the logos—including our own (top left)—to go to 
that organization’s Web site. 

Post Office Box 4005 
Dayton, Ohio 45401 

Telephone: 
(937) 222–4DMA 
(937) 222-4362 

Visit us at: 

DMA1.org 

Your 2015/16 
Oocers: 
President 
 Debra McFall 
Vice–President 
 Gary COY 
Secretary  
 Glady CAMPION 
Treasurer 
 Pat FLYNN 

Oocers need not be Trustees. 

Trustees: 
 Martin ARBAGI 
 Glady CAMPION 
 Gary COY 
 Patrick FLYNN 
 Debra MCFALL 
 Ken PHELPS 
 Ed SKUYA 
 Gary TURNER 
 Jim ULLOM 

Webmaster: 
 Dave LUNDY 

 

Submissions …  

T he Databus welcomes compliments, complaints, suggestions, and es-
pecially articles. We can accept articles in ASCII, or as attachments in 

Microsoft Word or Works, Open Office Writer, Word Perfect, or, yes, even 
WordStar (a word–processing program that goes all the way back 
to the 1980s!).  We can now also accept PDF files. Send articles to: 

Editor@DMA1.org 

 All articles are subject to editing for spelling, grammar, usage, and 
space. Always retain a copy of your work, as The Databus cannot be re-
sponsible for loss. When articles are of roughly equal quality, those by 
paid–up DMA members usually receive preference. 

A ll registered trademarks, for example: DMA, Lenovo, Staples, or 
Windows, are the property of their respective owners. However, for 

better readability, the Registered Trade Mark symbols (® or ™) have been 
omitted. The Editor occasionally inserts comments into articles. Such com-
ments are usually in square brackets [ like these] and are always preceded 
by the phrase: “Editor’s Note.” 
 The Databus is written and published by volunteers. We do not give pro-
fessional advice on computer, network, or software installation, trouble-
shooting, or repair. If you need expert assistance, please seek the services 
of a competent professional. 

http://www.dma1.org/
http://apcug2.org/
http://www.ascdayton.org/
http://www.dma1.org/
mailto:Editor@DMA1.org
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October Meeting: Catherine Devlin: WHAT DOES THE  
GOVERNMENT KNOW ABOUT YOU, & HOW CAN YOU FIND OUT? 

7:00 P.M., Tuesday the 27th, at T. J. Chumpp’s, 7050 Executive Blvd, Huber Heights  45424 
Click here for a map. No charge—Guests welcome—Bring a friend 

Meeting starts at 7:00 P.M., but come at 6:00 if you want dinner. 
Data.gov represents a new Federal commitment to make the government’s data available to its citizens 

—not just theoretically available if you jump through all the right hoops, but conveniently available for 

easy analysis. We’ll take a survey of some of the kinds of data available and introduce some techniques 

(like API usage and data conversion) you might use to download and analyze it. 

 Open government data is im-

portant because the more accessible, dis-

coverable, and usable data is,  the more 

impact it can have. Data.gov is a rich re-

source for civic hackers, tech entrepre-

neurs, data scientists, and developers of all 

stripes. The site is powered by two open 

source applications, CKAN and Word-

Press, and is developed publicly on 

GitHub. Catherine Devlin is a long-time  

member of DMA, a great speaker, and leader of the Dynamic Languages SIG. She is the founder of Day-

O, the Dayton Oracle SIG, yadda, yadda, yadda, PyOhio, and speaker at several developer conferences 

such as PyCon, PyTennessee, Ohio Linuxfest, and Python Workshops for Women. An extensive Web 

search revealed that she currently works as an Innovation Specialist with the 18F team of the GSA. 

 We continue to meet at the T. J. Chumpp’s in Huber Heights. Same great cuisine as the Fairborn res-

taurant, and this location is quieter. It’s just off I-70, exits 36 (if you’re going east [for example, coming 

from Englewood]) or 38 (if you’re going west [for example, coming from Springfield]), not far from the 

Meijer’s. There’s plenty of free parking. Click here for a map. In addition, T. J. Chumpp’s in Huber 

Heights is accessible via RTA bus routes #18 (Meijer’s and Executive Boulevard stop) and 19 (same 

bus stop — click on the route numbers for maps and schedules). All DMA meetings are free and open to 

the public, so please bring a friend. 

(Since the main meeting will be at a restaurant, there will be no 

Pizza SIG gathering afterward.) 
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https://www.google.com/maps/place/7050+Executive+Blvd,+Dayton,+OH+45424/@39.8700739,-84.1077,16.5z/data=!4m2!3m1!1s0x883f7d212c61a39f:0xfe89b58f6eda29b9
https://www.google.com/maps/place/7050+Executive+Blvd,+Dayton,+OH+45424/@39.8700739,-84.1077,16.5z/data=!4m2!3m1!1s0x883f7d212c61a39f:0xfe89b58f6eda29b9
http://www.i-riderta.org/sites/default/files/schedule_pdf/RTA-Route18_3.pdf
http://www.i-riderta.org/sites/default/files/schedule_pdf/Rt%2019%20schedule%2010-25-15.pdf
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M inutes are usually published almost two months late. This is because the Minutes for, say, 
the September Board meeting must be approved by the Trustees at the following month’s 

meeting—in this case, early October. The corrected and approved September Minutes will thus ap-
pear in this (October) issue, published toward the end of the month. The next Trustees’ meeting will 

be on November 2 at the Chestnut Street Community Room of the Greene Shopping Mall, just 
around the corner from the Mongolian Grill. The meeting begins at 7:00 p.m. (Please come at 6:00 if 
you’re joining us for dinner at Louie’s Bar, near the Mondolian Grill.) 

MINUTES 
DMA Board of Trustees-Meeting of Monday, September 14, 2015 

CALL TO ORDER 
 The meeting was called to order at 7:21 P.M. by Gary Coy. Trustees present: Martin Arbagi, Glady 
Campion, Gary Coy, Debra McFall, Eric Ottoson, Wynn Rollert, Ed Skuya and Gary Turner, Jim Ul-
lom. Others Present: Peter Hess. 
OFFICERS’ REPORTS 

President-Gary Coy 
 T.J. Chumpps seems to be a good meeting place for us. We need to let members know they don’t 
have to eat there if they want to come to the meeting. We could consider this location for our Christ-
mas Party. 
Vice President-Eric Ottoson 

 No report. 
Secretary-Debra McFall 
 Debra presented the Minutes for the August Board meeting. Eric Ottoson moved the Minutes be 
accepted. Jim Ullom seconded and the motion passed. 
Treasurer-Glady Campion 
 Glady presented a revenue and expense report for January 1 through August 31, 2015. Our Fifth 
Third Checking Account has a balance of $18,338.11. Our Fifth Third Savings Account as a balance of 
$11,219.89. Our Dayton Foundation Account has a balance of $78,488.72. Our Paypal Account has a bal-
ance of $705.12. This gives us a total of $108,751.84. 
COMMITTEE REPORTS 

Audit-Glady Campion 
 -
nished, we will have another audit next year for 2015. 
Bylaws Review-Eric Ottoson 
 Eric had a meeting with Lillian Rudolph and Grant Root and the Bylaws changes have been made.  
They will be presented to the Board for approval. 
Funding—Open 
 No report. 
Membership-Glady Campion 
 We have 68 regular members, 2 associate members, 0 student members and 2 life members for a 
total of 72 members. There were 38 people at the August meeting and the 50/50 brought in $37. 

(Continued on page 5) 



October 2015         The Databus                  Page 5 

Net Admin Team-Ken Phelps, Gary Turner 
 Gary Turner needs to check Google Apps to make sure everything is in order and that DMA is dis-
connected from the Dallas Museum of Art. 
Programs-Jim Ullom 
 We are planning a meeting on Digital Forensics for September. In October, Catherine Devlin will 
give a presentation on what information the government has on you and how to get it. In November, 
Martin Arbagi will give a presentation on Keypass. 
Publications-Martin Arbagi 
 There was no August DATABUS because of Martin’s surgery, but we will have an August/September 
DATABUS soon. 
OLD BUSINESS 
Storage Locker Clean-Up Committee-Debra McFall, Glady Campion 
 Wynn Rollert will move his items out of the storage locker by Friday. We will get a 5 X 5 storage 
locker soon. 
Records Committee-Debra McFall, Glady Campion, Eric Ottoson, Wynn Rollert, Martin Arbagi 
 We will meet to develop standards on which records need to be shredded, kept or archived and 
then present the ideas to the Board. 
Board Meetings-Glady Campion 
 The next Board Meeting will be held on Monday, October 5, 2015 at 7 P.M. at The Greene Commu-
nity Room on Chestnut Street near the Ritch Building.  If you would like to eat with us first, please 
come at 6 P.M. to Bar Louie [sic], 4492 Glengarry Drive, Beavercreek, OH  45440. 

(Continued from page 4) 

(Continued on page 6) 

Have a business card? Are you a DMA member? 

A ny paid–up member of the Dayton Microcomputer Association is entitled to a free business card–

sized advertisement in The Databus. At this month’s meeting, give your card to Editor Martin 

Arbagi to be scanned, or send a good–quality image to Editor@DMA1.org A link to your Web site (if 

you have one) can be embedded in the image of your card. Under weird IRS regulations, your site may 

not include discount coupons for DMA members, although discount offers may be included in the ad-

vertisement itself. See the example below right, which includes a member discount. 

 

10% Discount to DMA 
members! 

mailto:gcoy@woh.rr.com
mailto:Editor@DMA1.org
http://locknestmobilelocksmith.com/
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Help DMA by using Amazon’s 

“Smile” program! 

A mazon, the Internet’s largest retailer (if you haven’t no-
ticed, Amazon isn’t just for books any more!) has a “Smile” 

feature whereby Amazon donates a percentage of almost any 
purchase you make to a selected nonprofit organization. There is 
no extra cost to you. Click here to learn more or here to go di-
rectly to the sign-up page. Be sure to put DMA down as the 
beneficiary of your purchases. 

Summer Picnic-Glady Campion (for Martin Arbagi) 
 The Summer Picnic was a success.  We had 26 people in attendance and we made $16.37.  Lou 
Tamburino won the Winbook. 
Nominations Committee-Ed Skuya 
 Ed will try to recruit members to run for positions that are coming open.  Pat Flynn, Suzette De 
Guzman,  Ed Skuya and Ken Phelps may run for positions on the Board. 
NEW BUSINESS 
 Ed Skuya noted that we had two or three people attend our last main meeting as the result of our 
City Paper ad.  We need to consider running more ads in the future to attract new members. 
 Peter Hess attended our meeting and presented a new value added product to be initiated by Cine-
mark Theatres.  Cinemark may host an event in the future that will allow guests to participate in at-
tempting to hack the wi-fi for Cinemark for one evening to identify security vulnerabilities.  More in-
formation is to follow. 
 Eric Ottoson moved to adjourn at 8:58 P.M.  Wynn Rollert seconded and the motion passed.  
 

Respectfully Submitted, 

Debra McFall, Secretary 

(Board of Trustees’ Minutes—Continued from page 5) 

https://smile.amazon.com/about/?ref=spkl_3_0_2055499922&ie=UTF8&pf_rd_m=ATVPDKIKX0DER&pf_rd_s=desktop-auto-sparkle&pf_rd_r=08XEYSPQPYZ9W0BKR5WF&pf_rd_p=2055499922&pf_rd_t=301&pf_rd_i=amazon%20smile&qid=1427474572
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—Musings: An Irregularly Written Column— 

By A. A. ARUNDEL 

Dayton Microcomputer Association, Inc. (DMA1.org) 

T 
HERE SEEMS TO BE A GROWING TREND among retailers to close on Thanksgiving this year. Over the 

past couple of years more retailers have opted to close on the holiday (Lowes and Staples are two 

recent examples). Maybe Black Friday will regain its spot as the largest retail shopping day of the year. 

I am claiming that the sweet spot on thumb drives has moved up to either 64 GB or 128 GB. The 

reason for this is that I recently broke down and bought a brand name 128 GB, USB 3.0 thumb drive for 

under $30.00. 64 GB drives were somewhere around 16 or 17 dollars. 

Speaking of price drops, have you noticed the drop in prices of SSD drives. A year ago 960 GB SSDs 

were selling for just under $1000. The other day I saw on for under $300. Laptop prices have dropped 

also. I saw a Lenovo i5 laptop for under $375.  

For those of you who still question the cloud let me give you a couple of recent facts. Microsoft’s 

Azure Cloud Platform performed so well that it led the Redmond based company to an eight percent 

increase in revenues, despite disappointing sales of Windows 10 and its phones. If you owned Mi-

crosoft stock you had a good week. Amazon also did well with its Amazon web services (AWS) lead-

 

Also related to cloud services is a recent statistical release which says that over 50% of large busi-

nesses say that the cloud is an important part of their infrastructure. 

Again speaking of the cloud, have you noticed that Dell is poised to get into the cloud marketplace 

in a big way? Dell is purchasing EMC a large cloud service company. This should give Dell an immedi-

ate influential presence as a cloud service provider. 

For those of us who would like to invest in the stock market but don’t have the money there are 

new apps out there that help you invest with as little as $5.00.  If you are interested it might be worth 

a Google search.  

Competition in the higher end laptops has ignited as Microsoft has released its Surface 4 and Sur-

face Book has ignited competition among vendors. So far I have seen Dell and Lenovo with competing 

offerings. Be prepared to pay the better part of $1500 for these babies.                            … TDB 

DMA1.org
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—Control Layout in Word With Page and Column Breaks— 

Nancy DEMARTE, 1st Vice President, Sarasota Technical User Group, FL 
September 2014 issue, Sarasota Technology Monitor 
www.TheStug.org  
ndemarte (at) Verizon.net 

M 
OST OF US DON’T WRITE BOOKS OR LENGTHY TREATISES. But now and then we use our comput-

ers to write multipage documents like newsletters, articles, and reports. Microsoft Word of-

fers special tools to assist in keeping text in longer documents where we want it. Among my favorites 

are the various tools for controlling where one page or a section of a page ends and the next begins: the 

“Breaks” tools. This article explores the Page Break tools. Next month’s article will deal with Section 

breaks. 

 There are times when you want the next 

part of a document to begin on a new page, such 

as the body of a report after an introductory sec-

tion. Rather than pressing the Enter key several 

times to get to the next page, the Page Break 

tool lets you end the introduction wherever you want on one page, and then begin the body of the doc-

ument on the next. Because the Page break tool holds the break in place, you can return later and add 

text or a graphic to the introductory page without disturbing the text on the next page. Word has al-

ways had a Page break tool, but many home users don’t bother with it. Learn about its functions and 

you’ll see its value. 

 The Breaks tools are found on the Page Layout tab in the Page Setup group in Word 2013, which I  

am using as the example in this article. In older versions, the Page break tool is on the Insert menu. 

[Editor’s Note: The Page Layout tab is substantially identical in both Word 2010 and 2013.] 

 Click the down arrow to the right of Breaks to see the three Page break options. To use the Page 

break tool, click at the end of the last word (plus 

punctuation) that you want to leave on the current 

page. Then click the Page break icon. This ends the 

page at that spot and moves the following text to the 

top of the next page. I use this tool so often that I have 

it in my Quick Access toolbar above the ribbon where 

it is always handy.  
 

(Continued on page 10) 

http://www.thestug.org
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 
Click anywhere on the DMA Calendar (above) to 

go to the original at DMA1.org. 

http://www.whitewatervalleyrr.org/
http://www.dma1.org/cgi-bin/webcal.pl
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—SIG News— 

S IGS ARE SPECIAL INTEREST GROUPS, an unusual feature of DMA. They range from the obvious 

(dynamic computer languages and the Linux operating system) to the not so obvious (genealogy 

and investments). All DMA SIGs emphasize the uses of digital technology and tools for business, hob-

bies, or other special interests. DMA Bylaws require all SIG to be members of DMA. We 

encourage all SIG members also to join the parent organization. 

 Send announcements for your SIG to Editor@DMA1.org. Two things to remember: 

 Leave notices of regular meetings to the DMA calendar. (See page 9.) However, notic-
es of special events, cancellations, or postponements are welcome. 
  Please give us enough time. THE DATABUS comes out at the end of each month. A notice 
of an event that occurs, say, on the 19th of November would not be published in the Novem-
ber issue of THE DATABUS until after your meeting had taken place. It should have been in this 
(end of October) issue. 

The Investment SIG will not meet this month because Martin 
Arbagi, SIG Chairman, will be in Denver, CO. 

 

Sometimes page breaks can cause unexpected results. For example, editing a document after in-

serting a page break can result in a blank page in the middle of the document. Deleting the break will 

eliminate the blank page, but in normal view, the page break indicators are not visible. To make them 

visible, turn on the Show/Hide tool (Home tab - Paragraph group - Paragraph symbol). The Page break 

indicator is a horizontal dotted line with the phrase, Page Break, in the middle. To delete a page break, 

drag over the dotted line to highlight it, then press Backspace or Delete.  

 The Column break tool works the same way as Page break, but its purposes can be different. If 

you have formatted your document into two columns, for example, you can add a column break at any 

ten this is done to make columns more even in length. This tool is useful in a newsletter when you 

want an article with two equal length columns extending partway down the page, making room for a 

photo or second article below. [Editor’s Note: Nowadays, many newsletters, such as this one, are 

(Continued on page 11) 

mailto:Editor@DMA1.org
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published on line. Multi-columned format is not recommended for such publications, unless the Edi-

tor is certain that most readers will actually print it rather than read it directly from the screen. Read-

ing from the screen of a monitor is different than reading from a sheet of paper, and using more than 

one column for an on-line publication slows down reading speed.]  
 

 To add a column break, click at the beginning of the line 

you want to move to the top of the next column. Choosing the 

correct line sometimes takes a few tries to get the even column 

effect you want. The column break indicator looks like a page 

break indicator and is deleted the same way.  

 The third tool in the Page break group is the Text-

wrapping break. Although intended for Web pages, it can be 

helpful in Word documents. If you have added a photo, table or other object to a document, and would 

like to put some text, like a caption, around or below the object, this break option can hold it in place 

better than using the Enter key or adding a text box. More information on text-wrapping will be 

found in a future article. 

 Word has another set of options relating to page breaks: 

the Line and Page Breaks options found on the Home tab – Para-

graph group in the dialog box. Click the diagonal arrow in the bot-

tom right corner of the Paragraph group to see this box.  

Next click the Line and Page Breaks tab to see the options, which have been part of Word through 

many editions. Understanding them can help you solve 

Widow/Orphan 

Control, selected by default, prevents a single line of a 

paragraph from being left alone at the bottom or top of a 

page. Word will automatically move the paragraph to 

the next page rather than leave even a one word line by 

itself. (Hence, the tool’s name.) Since this action can sometimes leave more blank space at the bottom 

of the page than I want, I often shorten the paragraph to keep Widow/Orphan control from taking ef-

fect. 

 The next option, Keep with next, ties the current paragraph to the following one. Keep in 

mind that in Word, any time you press Enter, a new paragraph is created. Therefore, this option helps 

(Continued from page 10) 

(Continued on page 12) 
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keep a heading with the paragraph it relates to, rather than leave the heading at the bottom of one page 

and its related paragraph on the next. Keep lines together simply keeps all lines of a paragraph to-

gether on the same page. You can see how that might add a lot of blank space in a document. The last 

option, Page break before, inserts page breaks so that each paragraph in a document will begin at the 

top of a page. Generally, these three options are only useful in special situations. To enable one, click 

its checkbox - OK. If you want any of them always to be in effect, also check “Set as Default” at the 

bottom of the dialog box.  

 Word offers ways to control many more aspects of a document than most of us realize. Getting to 

know what the options are can give us more tools to use when we need them.                                                          … TDB 

(Continued from page 11) 
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DMA Membership Application/Renewal 

PLEASE ALLOW UP TO THREE WEEKS FOR APPLICATION PROCESSING AND INTERNET SET–UP 
 

Name: ____________________________________________________________________Birth date:_____/_____/_____ 
 mo. day year 

 
Associate Name: ____________________________________________________________Birth date:_____/_____/_____ 

 mo. day year 
Address: ____________________________________________________________________________________________ 
 
City: ___________________________________________________________________ State: ________ Zip: __________ 
 
Phone: (Home) (________) ___________-_____________ (Work) (________) _________–______________x___________ 
 

I wish to have my name and address published in the club roster: YES  NO  

 
E–mail address: ____________________________________________@________________________________________ 
 
 
Name of DMA member who recruited me: _______________________________________ (only new regular memberships)  
 
Are you a current or recent DMA Member? Yes q No q Change of Address only? q Today’s date: _____/_____/_____ 

 
If you are renewing, please give your Membership Number (from your membership card) _________________________ 

Type of Membership 
 

Application is for: New Membership  Membership Renewal  Associate Membership*  
 

If applying for free student membership, please give school name and student ID number: Available only for students un-
der 22 years old. (Student Members cannot vote in DMA elections.) 

 
School Name: ______________________________________________ Student ID#: _______________________________ 
 

* A family or associate membership is an additional membership for a member of your immediate family or someone else who is liv ing in the member’s 
household. If this is a family or associate membership, give name of regular member:  
 

Dues/Fees (Dues and Fees are subject to change without prior notice): 
 

Membership (one year — New or Renewal)  1.)  $25.00 

 

Family or Associate Membership (must live at same address as regular member)  2.) $12.50 
 

Free Student Membership for students under 22 yrs of age. (Student Members cannot vote in DMA elections.) 
  3.)  FREE 
 

Please assign me a user ID for E–mail and Usenet news access one–time setup 4.)  $10.00 
fee for new E–mail accounts. 
 

Total — Lines 1 and 2 (+ 4 if checked)  5) $_____________ 
 

Make your check payable to Dayton Microcomputer Association, Inc. (DMA), and then send the check and application to: 
 PO Box 340402 
  Beavercreek, OH 45434–0402 
DMA Use only: Membership # __________________  
Exp. Date: __________/_________/______________ 
Processed by: ________________________________ 
REV: 25 November 2013 

Cash 

Check 

Check # ____ 

Click here to pay your dues 
using PayPal. Simplified 
Membership Form, too! 

http://www.dma1.org/dma_member_form.html

